Extension Owner User Guide

Switchvox SMB version 5.8
## Contents

- Overview 8
- Setup 9
  - My Account 9
    - Voicemail and Extension Suite Password 10
    - Language/Locale 11
    - Sound Prompt Language 11
    - Profile Picture 11
  - Additional Numbers 12
  - Phone Features 13
    - Phone Settings Tab 14
      - General Settings 15
      - Msgs Button 15
      - Idle Screen 15
      - Display 15
      - Sounds 15
      - Answering Calls 16
    - Ringtones Tab 16
      - Create Ringtone 18
      - Distinctive Ringtones List 18
    - Ring Rules Tab 18
      - Create Ring Rule 19
      - Create Ring Rule Condition 20
      - Call Type Settings 21
      - Extension Options 21
      - Caller ID Options 22
      - Ring Hint Options 22
      - Changing a Ring Rule or Condition 22
  - Converged Phones 23
    - Creating and Managing a Converged Phone 24
    - Create Converged Phone 24
2 Call Rules & Status Options 30

Call Rules 31
Tab Characteristics 31
Activating Call Rule Sets 31
Prioritizing Call Rule Sets 31
Prioritizing Actions in a Call Rule Set 31
Unanswered Call Rule Sets 32
Create Call Rule Set 33
Create Action 34
Send to Voicemail 34
Call Forward 35
Call Cascade 35
Secret Code 37
Ring All 37
Decline 39
Prioritizing Actions 39
Modifying a Call Rule 39
Activating a Call Rule Set 40
Busy Call Rule Sets 40
Call Blocking Rules 41
Create Call Block Rule 41
Messages/Prompts 42
New Sounds (Messages) 43
Play Sound 43
System Default Sound 43

Time Frames 43
Managing Time Frames 44
Create Time Condition 45
Modifying a Time Frame 45
Deleting a Time Frame 45
Sample Time Frames 46
All Mondays and Wednesdays 46
Early Morning 47
The First Week in July 2012 47
Weekdays in February 2012 between 6:00 and 7:00 in the morning 48
After January 21, 2012 48

Status Options 49
Create Status Option 50

3 Calling & Contacts 51

Phonebooks 52
Create Phonebook Entry Tab 53
Extension 54
Phonebook 54
Extension(s) 54
Permission Type 55
External Number 55
Phonebook 55
Number 56
Name 56
Jabber ID 56
Agent Login Extension Indicator 56
Phonebook 56
Entry Name 57
Agent Login Extension Indicator 57
Queue To Monitor 57
Parking Space Indicator 57
Phonebook 57
Entry Name 57
Parking Space 57
Create Phonebook Tab 58
Modify Phonebook Options Tab 59
Phonebook for Rapid Dial Keys 59
Digium Phone Contact Settings 59
Enable Line Keys for Rapid Dial 59
Blind Transfer Rapid Dial 59
Number of Rapid Dial Subscriptions 59
Additional Numbers 60
Conferencing 61
General Settings 62
Your Conference Room Number 62
Play sound when people enter/leave 62
Sound Type 62
Play Music On Hold when only 1 member is in the conference room 62
Conference members may press # and be sent to extension [] 62
Conference Admins 62
Admin Settings 63
Only allow conference admins to talk 63
Hang up conference when all conference admins leave 63
Users cannot talk until a conference admin is in the conference room 63
Digium Phone Calling Features 63
Dialing Calls 63
Receiving Calls 64
Redial 64
Hold/Resume 64
Transfer 64
Assisted 64
Unassisted (blind) 64
Transfer to Voicemail 64
Park 64
Record/Stop Record 65
Three-way Conference 65
Digium Phone Apps 65
Status App 65
Contacts App 65
Queues App 66
4 Voicemail and Fax  67

Voicemail Options  68
  Greetings Tab  68
  Voicemail Notifications Tab  69
    Create Voicemail Notification 70
  Notification Templates Tab  71
  Forwarding Tab  73
    Forwarding Options 73
    Forwarding Destinations 74

Mailbox  74
  View Folder  75
    INBOX (Voicemail) folder 75
    Fax Folder 75

Fax Options  76
  Notifications Tab  76
  Sending/Receiving  76
    Previewing 77
    Deleting 77
    Moving to another folder 77
    Forwarding 77
    Print a fax-file 77
    Send the fax 77
    Treat All Outgoing Calls as Faxes 77
    Fax Header 78
    Advanced Options 78

Digium Phone Voicemail App  78

Digium Phone Voicemail System Options  78

Putting the Mailbox on Your Desktop  79
  Subscribing to Folders  80

5 Faxing  81

  Setting Up a FAX Printer  81
  Sending a Fax  82

6 Reporting  83

  Call Logs  83
  Call Reports  84

7 Switchboard  85

  Using the Switchboard  86
  Options  88
    Save Layout  88
    Panels  88
    My Phone  88
  Switchboard Panels  89
    Current Calls  89
Overview

Typically, everyone in an organization has been assigned an extension number associated with a Digium Phone and the Switchvox system. Switchvox uses these extension numbers to send calls to various destinations.

The web-based Switchvox Extension Tool Suite (also called the Extension Suite, the web suite, or /main) is the primary means to manage your extension and Digium Phone. The web suite is comprised of these sections:

- **Features.** Tools to set up and manage your account and features such as Phonebooks, Call Rules, and Converged Phones.
- **Voicemail and Fax.** Tools to check and manage your voicemail and faxes, set up notifications of incoming messages, and record your voicemail greetings.
- **Reporting.** Tools to get detailed information about your calls and to run usage reports.

You can access the web suite from any computer on your network via a web browser, using your extension number and a numeric password. The web suite’s URL can be found on the *Welcome to the Digium IP Phone* sheet that came with your phone.

This guide includes basic how-to information so extension owners can quickly get acquainted with and effectively use their Digium Phones and the Switchvox system. It steps you through important features of the suite. And it introduces the Digium Phone Apps and describes features of Switchboard, the Switchvox graphical interface.

Setup, page 9
Call Rules & Status Options, page 30
Calling & Contacts, page 51
Voicemail and Fax, page 67
Faxing, page 81
Reporting, page 83
Switchboard, page 85

For additional documentation and other technical support information, refer to the Support page of the Digium website (http://www.digium.com/en/supportcenter/).
1 Setup

The following setup operations, all accessed from the Extension Suite, Features section, are described in this chapter:

- My Account, page 9
- Voicemail and Extension Suite Password, page 10
- Language/Locale, page 11
- Sound Prompt Language, page 11
- Profile Picture, page 11
- Additional Numbers, page 12
- Phone Features, page 13
  - Phone Settings Tab, page 14
  - Ringtones Tab, page 16
  - Ring Rules Tab, page 18
- Converged Phones, page 23
  - Creating and Managing a Converged Phone, page 24
- InCall Menu, page 28

My Account

My Account lists the Profile Information associated with your Switchvox extension. After logging into the Extension Suite with your phone extension, go to

Features > Account > My Account
This displays the My Account page for your phone extension.

![My Account Profile Information page](image)

**FIGURE 1.** My Account Profile Information page

If your administrator has given you permission to change your profile information, you can change it from this page. This includes editing your voicemail/web suite password, name, email address, title, language setting, uploading a profile picture, and other things.

When finished making changes, click **Save Account Information**, and the system displays:

Successfully modified your account.

---

**Voicemail and Extension Suite Password**

- To make a new password, enter a minimum of three numbers in the **Numeric Password** text box. The strength of the password is indicated as you enter it to help you create the most secure password.
- For verification, enter it again in the **Retype Numeric Password** text box.
• Click **Save Account Information** to save the new password. You are logged out, and you must use the new password to log back in.

**IMPORTANT**: This changes the password for both your voicemail and Extension Suite access.

**Language/Locale**

The Extension Suite is available in several languages. If you wish to change the language/locale, select one of the following from the Language/Locale dropdown menu:

- English / United States
- English / United Kingdom
- Español / España
- Español for México
- Italiano for Italia
- Français for France

**NOTE**: All Language/Locale settings except English / United States use the following format for dates:

`dd/mm/yyyy`

This means 30/11/2011 denotes November 30, 2011.

**Sound Prompt Language**

If there are one or more sound packs available, you can select a language from the Sound Prompt Language dropdown menu. The language selected will be what your extension hears. For example, if you select Italian, when you call your voicemail access extension, all prompts will be in Italian.

**Profile Picture**

To add a picture to your profile, click the **Upload Picture** icon and follow these steps:

- Click inside the **Choose Image** text box to find an image file on your computer. Then click **Upload Image** (clicking **Cancel** ends the operation).

  The image is uploaded and displayed with the crop area that will be used to make a 75x100 pixel image. You can move the crop area around to choose the best portion of the picture. The Preview shows you what the picture will look like after it is cropped.

  **NOTE**: Images must be JPG files of at least 75x100 pixels.
• When ready, click **Upload Image**.
• If you want to re-crop a picture, click **ReCrop** (pencil icon).
• If you want to delete a picture, click **Delete** (X).
• If you want to upload a different image, delete the already uploaded image, then click **Upload Image** to start again. Confirm your changes.

Your picture is displayed in the profile panel of your coworkers in Switchboard.

---

**Additional Numbers**

The **Additional Numbers** option associates other phone numbers and extensions to your profile and account. This is useful to help others in your organization find you when you are away from your desk. For example, you can add your mobile phone number, your home phone number, or even another extension you use frequently.

**IMPORTANT**: If you have other phone numbers you use often, you may want to add those numbers to your **Converged Phones**, rather than making them Additional Numbers. (See [Converged Phones, page 23](#).)

To create an additional number, go to **Features > Account > Additional Numbers**.

![Account Additional Numbers page](#)

**FIGURE 2.** Account Additional Numbers page

This displays the **Additional Numbers** page, which lists any existing numbers you may have created and allows you to create more numbers.
• Click **Create Additional Number** to display its popup.

![Create Additional Number popup](image)

**FIGURE 3. Additional Number popup**

• Enter a **Title** (name) for the number.
• Enter the phone or extension **Number**.
  IMPORTANT: Enter the number as you would dial it from your phone. For example, begin the number with a 9 or an area code, if that is how you normally dial that number from your phone.
• Select an icon from the **Icon** dropdown menu to associate with the additional number (for example, mobile phone, home, etc.).
• Click **Save Additional Number**, which redisplays the screen that now includes the additional number.
  NOTE: The number, icon, and title are also displayed in the Phonebook entries of your coworkers.
• Click the pencil icon for an Additional Number to modify it.
• Click its red X to delete it.
• Use the green arrows to change the order in which the additional numbers are displayed.

**Phone Features**

To customize how your Digium Phone works, go to

**Features > Features > Phone Features**

The **Phone Features** page has three tabs: **Phone Settings**, **Ringtones**, and **Ring Rules**.

IMPORTANT: If you make changes to any of the phone features, your phone will be reconfigured.
**Phone Settings Tab**

To make changes to your Digium Phone Settings, go to the **Phone Settings** tab under **Phone Features**. This displays the **Phone Features** page for **Phone Settings** for Digium Phones.

**NOTE**: The settings under the **Other Manufacturers** tab are disabled if you have a Digium Phone.

![Figure 4: Phone Settings for the Digium Phones page](image)

The following paragraphs describe the options for Digium Phone Settings. After making changes, click the **Save Phone Settings** button to commit the changes.
**General Settings**  

*Line Label* sets the label displayed on the phone's Line Key for this extension.

- Enter a specific label in the *Line Label* text box. The Actual Display is shown under the text box.
- Or you can build a dynamic line label with variables to describe the label. Select the variable from the dropdown menu, then click *Append*. The variable is entered in the *Line Label* text box, and the actual display is shown under the text box.

Variables are most useful for Switchvox Administrators when creating multiple extensions, but are less useful to individual users.

**Msgs Button**  

*Msgs Button Action* sets what the phone does when its *Msgs* button is pressed.

- To use the phone Voicemail application to navigate via the phone display, select *Open Visual Voicemail* from the dropdown menu.
- Or to call the voicemail system extension and navigate via sound prompts, select *Dial Voicemail Extension* from the dropdown menu.

If you select *Dial Voicemail Extension*, you can either enter an *Extension* or search for and select an *Extension*. The system informs you if no extensions are available. The default Voicemail extension number is 899. See *Voicemail and Fax, page 67* for more about Voicemail.

**Idle Screen**  

*Idle Screen Image.* This changes the image that displays on the phone's idle screen.

- To change the image, click the *Upload Picture* icon. This displays a popup from which you can search for an image on your computer and upload it or cancel the operation.
- To display a notification in the top-left corner of your phone’s idle screen, click *YES* for *Display Missed Calls Notification*.

**Display**  

*Brightness and Contrast.* Use the sliding control to adjust the brightness and contrast in your phone’s display.

*Backlight Dimming.*

- Click *YES* to dim the backlight after the phone is not in use.
- Enter the number of seconds before dimming in the *Seconds until Backlight Dim* text box.
- Use the sliding control to select the Backlight Dim Level. Level must be less than the brightness.

**Sounds**  

*Default Ringtone.* Select the default ring tone to use for incoming calls from the dropdown menu (unless you have set up one or more *Ring Rules Tab, page 18*).

*Reset Volume Every Call.* The volume can be changed during a call by moving the volume control bar on the phone. Select *YES*, to reset the volume to the default after each call.
**Answering Calls**

*Headset Answer.* Select YES to use the headset, not the speaker, when you press the Answer softkey on your phone during an incoming call.

*Electronic Hook Switch.* Options are Automatic, Plantronics, and Jabra IQ. If you select Jabra IQ, the Jabra headset must be set to IQ mode. If the Jabra headset does not support Jabra IQ, you may need to update the firmware on the headset. See the manufacturer’s documentation for more information.

*Auto-answer Switchboard initiated calls.* Select YES or NO to set your phone to automatically answer Switchboard-initiated calls. If you click on a Switchboard phonebook entry, normally your phone rings and you have to pick it up, then Switchvox dials the number for that entry. If this box is checked, your phone rings, then automatically goes to Intercom mode and answers the Switchboard, and you hear the phone ringing for the call to your phonebook entry.

**Ringtones Tab**

Switchvox can store and play ringtones that can be used on your Digium phone. Although there are limitations for the total number of ringtones and the total amount of disk space that can be used, you should have plenty of room to add the ringtones you like.

To view or make changes to the existing ringtones, go to **Phone Features** under Features and click the Ringtones tab.
This displays the Ringtones page, which lists both preloaded and uploaded ringtones. If you have added ringtones directly to your phone, they are not included in this list.

![FIGURE 5. Phone Features - Ringtones page](image)

Switchvox Extension Owner User Guide 17
Create Ringtone

Click **Create Ringtone** to display the **Create Ringtone** popup.

![Create Ringtone popup](image)

**FIGURE 6. Create Ringtone popup**

- On the popup, click in the **Choose a File** field to browse your computer files to find a WAV sound file.
- Enter a name for the ringtone in the **Name** field.
- Click **Save Ringtone** to upload the file (or **Cancel** to end the operation).

The Ringtones list is refreshed, showing your new ringtone.

Distinctive Ringtones List

Depending on the permissions you have for each ringtone, you can do the following to a ringtone displayed in this list:

- **Play the ringtone.** The audio file is downloaded to your computer, then played using your default audio player for WAV files.
- **Modify the ringtone** if it is not a preloaded file. You can upload a new file, or change its name.
- **Delete the ringtone** if it is not a preloaded file. You must verify that you want the ringtone deleted.

**NOTE:** If you delete a ringtone, all Ring Rules using that ringtone are also deleted.

Ring Rules Tab

Ring Rules define conditions for callers, or kinds of calls, and what the phone does when those calls come in.

To create a Ring Rule, go to **Phone Features** under **Features** and click the **Ring Rules** tab.

After you have created the rules and conditions, click **Save** and Restart your phone.
This displays the Ring Rules page.

FIGURE 7. Phone Features - Ring Rules page

After you have set up Ring Rules and restarted your phone, your ringtone disk space usage is displayed. This is specific to your phone and can help you decide which ringtones to use for your Ring Rules.

Create Ring Rule

Click **Create Ring Rule** to display its popup.

FIGURE 8. Ringing Settings popup

- Enter a **Rule Name**.
- Select the **Ring Type** (that is, the action your phone should take) from the dropdown menu. Options are
  - **Standard Ring** rings with the specified ringtone
  - **Auto Answer** answers in Intercom mode
  - **Ring, then Auto Answer** does both ring and answer in intercom mode
  - **Visual Indication** mutes the ring but the line still blinks
• If you have chosen a Ring action, select a **Ringtone** to associate with it from the dropdown menu.

• Click **Save Ringtone Rule**.

### Create Ring Rule Condition

Click the **Conditions** tab from which you must create the **Ring Rule Conditions** for the rule.

#### FIGURE 9. Ring Rule Conditions tab

Click **Create Ring Rule Condition** to display a list of types: Call Type, Extensions, Caller ID, and Ring Hints.

#### FIGURE 10. Types to apply to a condition
Call Type Settings

- Click **Call Type** to display the **Call Type Settings** popup.

![Call Type Settings popup](image1)

**FIGURE 11. Call Type Settings popup**

- Select a type from the **Call Type** dropdown menu to meet the respective conditions for the ringtone. Options are
  - **Direct Calls**. The incoming call was made directly to your extension (or to a DID that is directly routed to your extension).
  - **Queue Calls**. The incoming call comes from any queue.
  - **Internal Calls**. The incoming call originated in Switchvox.
  - **External Calls**. The incoming call originated outside of Switchvox.
  - **All Calls**. All calls coming into your extension.
- Click **Save the Condition**.

Extension Options

Click **Extensions** from the **Type** options to display the **Extensions Settings**.

![Extensions Settings](image2)

**FIGURE 12. Extensions Settings**

- Enter one or more extensions to which the condition applies to. If the incoming call is from any one of these extensions, the condition is met.
Caller ID Options

- Click **Caller ID** from the **Type** options to display the **Caller ID Settings**.

![Caller ID Settings](image)

**FIGURE 13. Caller ID Settings**

- Select a Caller ID Condition Type from the dropdown menu. Options are Number Pattern, Number Range, or Name Pattern.
  - **Number Range**. Enter a number range for the caller ID to which the condition applies. If the incoming caller ID is equal to one of these numbers, or it falls between them, the condition is met.
  - **Number Pattern**. Enter a number pattern the condition applies to. Use the asterisk (*) to indicate that any number matches. For example, 619555* matches every call with area code 619 and prefix 555. If the incoming caller ID number matches the number pattern, the condition is met.
  - **Name Pattern**. Enter a name pattern the condition applies to. Use the asterisk (*) to indicate that any letter matches. For example, *Smith matches every call from a name that ends with Smith. If the incoming caller ID name matches this text pattern, the condition is met.

Ring Hint Options

Ring Hints are used by an extension's Ring Rules to set up different Ring Actions, depending on the call. Ring Hints are created and managed by your Switchvox administrator. They can indicate almost anything, so check with your administrator before using this condition. If an incoming call has a Ring Hint associated with it, the condition is met.

Changing a Ring Rule or Condition

To change existing Ring Rules or Conditions do the following:

- Click the **Modify** icon (pencil) for a rule to change its settings, or one of its conditions, then click **Save**.
- Click the **Delete** icon (X) for a rule to delete it, or to delete one of its conditions.
Converged Phones

The Converged Phones option (under Features) allows you to join other Switchvox extensions and phones to your main extension so they appear to be your main extension. For example, you can converge your Switchvox extension at home and your mobile phone with your main extension on your desk so all three appear as the extension on your desk.

NOTE: You can have as many as six converged phones, including your main phone.

The following things happen when you converge a phone with your main phone:

• Your Switchvox voicemail messages and faxes all go to your main phone’s Switchvox mailbox.
• Your Caller ID is always that of your main phone, as long as the call originates from Switchvox. That means calls from your Switchvox extensions, or a Switchvox App such as Switchvox Mobile or Switchvox Notifier.
• All converged phone calls are included in your main phone’s call logs.
• In your Switchvox Switchboard, your Current Calls panel includes the current calls for the Converged Phone. You can act on those calls as you normally do. (See Switchboard, page 85 for a discussion of the Switchboard.)
• In your Switchboard, you can specify which of your Converged Phones you want to use. That way, when you click-to-call, the correct phone rings.
• In another person’s Switchboard, you appear busy on your main phone if you are on a call with any Converged Phone. With the correct permissions, your call information is visible, and it can be recorded, monitored, whispered, or barged into.
• In The InCall Menu, you can easily transfer calls between your Converged Phones.

On a Digium Phone, if line 1 is a converged phone (not a Main Phone), the main extension is used for the following:

• All voicemail activity message indicator light, the Msgs button, and dialing the voicemail system extension.
• Contacts, Status, and Call Queues Apps.
• Parking a call (the call appears to be parked by the main extension).
• Log into and out of a queue via a Status Indicator Rapid Dial Key. (See Agent Login Extension Indicator, page 56.)

Use the Extension Suite to set up specific Call Rules or Phone Features for your main phone and any converged Switchvox extensions so incoming calls ring your phones appropriately.

NOTE: The only time you should need to log into the Extension Suite for a converged phone is to set up specific Call Rules or Phone Features.
Creating and Managing a Converged Phone

To create and authorize a Converged Phone, log into your main extension and go to Features > Converged Phones. This displays the Converged Phones page.

Create Converged Phone

Click Create Converged Phone to display its popup.
• Select **External Number** to create a Converged Phone that is not part of Switchvox.

**FIGURE 16. Create Converged Phone External Number popup**

• Enter **Outgoing Dialing Prefix** and the **External Number** and set the options as appropriate (see Options, page 26 below).
• Or select **Extension** to create a Converged Phone that is another Switchvox extension.

![Create Converged Phone Extension popup](image)

**FIGURE 17. Create Converged Phone Extension popup**

• Enter the extension, and set the options as appropriate (see **Options** below).

**Options**

Each of your Converged Phones has a label and is available as a Rapid Transfer option in the **InCall Menu, page 28**. Rapid Transfer is “speed dial” for your InCall Menu. Enter or select the appropriate information as described in the following:

**Acknowledge Rapid Transfer.** Select either **YES** or **NO**.

If **YES**, when you use the Rapid Transfer option from the InCall Menu, Switchvox does not transfer the call until you have answered and acknowledged it by pressing ONE on your keypad.

If **NO**, Switchvox completes the Rapid Transfer as soon as the call is answered.

**Label.** For easy reference, enter a label (name) for this Converged Phone.

**Rapid Transfer Key.** Select a line key number from the dropdown menu to press on your phone's keypad to complete a transfer.

**Rapid Transfer Sound.** Select a sound from the dropdown menu to play in the InCall Menu to describe this Rapid Transfer option.
• Click **Save Converged Phone**. The new phone is saved and is now in the list of Converged Phones.

![Converged Phones page with List of Converged Phones](image)

**FIGURE 18.** Converged Phones page with List of Converged Phones

### Converged Phone List

- To verify that you can answer that phone, click **Authorize**. An Authorization Code is displayed.
- When that phone rings, answer it. Enter the Authorization Code on your phone's keypad.
- If prompted, enter the password for the Switchvox extension you are converging.
- Click **Save Converged Phone** when finished.

To modify a Converged Phone, click the **Modify** icon for the phone.

- Then make your changes.
- Click **Update Converged Phone**.

To delete a Converged Phone, click the **Delete** icon (X) for the phone.

- Verify you do in fact want to delete it.
- Click **Yes, Delete**.

**NOTE:** Phone numbers and extensions displayed in your Converged Phones list cannot be converged with another Switchvox extension. That applies to Switchvox extensions or to external phones. To add a converged phone from your list to someone else's Converged Phones, you must first delete it from your Converged Phones list.
InCall Menu

The *InCall Menu* lets you easily transfer or record a call from any of your Converged Phones. The InCall Menu works from any Switchvox extension, but your Converged Phone extensions have extra Rapid Transfer options for quick transfers to the phones you use often.

- To access the InCall Menu during a call, press the star key twice (***) on your phone's keypad. The InCall Menu answers, and its audio prompts help you decide what to do.

**NOTE:** You are the only one who hears the InCall Menu (your caller does not hear it); however, your caller may hear the tones from your keys being pressed, depending on how your call is being routed—over analog lines or over particular VOIP providers.

The following illustrates the InCall Menu options for someone who has three Converged Phones: 1) a main extension, 2) a mobile phone, and 3) a home phone.

**FIGURE 19. Switchvox InCall Menu Options**

The following paragraphs describes each of the options in the InCall Menu.

*Main Menu Rapid Transfer*

In the main menu, each of your Rapid Transfer numbers is offered, one at a time, from one through however many converged devices you have (up to six):

- To enter the menu, press **
- To transfer to your phone, press 1
To transfer to your mobile phone, press 2
To transfer to your Home phone, press 3
To exit this voice menu and return to your call, press *
For more options, press #

After you press a Rapid Transfer number, Switchvox rings the phone number for that Rapid Transfer option. When that phone is answered, the call is transferred. If that Converged Phone is set to Acknowledge Rapid Transfer, then you must acknowledge the call to complete the transfer. (For details, see Converged Phones, page 23.)

**Options Menu**

**Transfer and Recording**

From the main menu, you can choose more options by pressing **#, then one of the following:

- To transfer a call, press 1
  Your call is put on hold, and the Transfer options continue (see below).
- To transfer this call to your voicemail, press 2
  Hang up the phone and your call is transferred to your voicemail box.
- To start/stop recording this call, press 3
  The beep indicates recording has started, or recording has stopped.

To exit this menu, press *

**Transfer Menu**

From the options menu, if you can choose to transfer a call by pressing **#, then one of the following:

- To perform an assisted transfer, press 1
- Enter the extension you want to call. If you need to use the Directory to find an extension number, use assisted transfer and call the Directory.
- Confirm with that person you are going to transfer the call.
- Press **1 to perform the transfer, or press **2 to cancel the transfer.
- To perform a blind transfer, press 2, and enter the extension you want your call transferred to.

To exit this menu, press *
2 Call Rules & Status Options

Call Rules determine how Switchvox handles calls to your extension. Based on the day, time, and your Status, you can ring several phones, forward the call somewhere else, send the call straight to your voicemail, etc. If you use multiple phones, you can converge the other phones with your main extension. Then if you answer any of your phones, your presence is displayed as busy.

The following are the call rule and status options described in this section:

- Call Rules, page 31
  - Tab Characteristics, page 31
    - Activating Call Rule Sets, page 31
      - Prioritizing Call Rule Sets, page 31
      - Prioritizing Actions in a Call Rule Set, page 31
  - Unanswered Call Rule Sets, page 32
    - Create Call Rule Set, page 33
    - Create Action, page 34
    - Prioritizing Actions, page 39
      - Modifying a Call Rule, page 39
      - Activating a Call Rule Set, page 40
  - Busy Call Rule Sets, page 40
  - Call Blocking Rules, page 41
  - Messages/Prompts, page 42
    - New Sounds (Messages), page 43
    - Play Sound, page 43
    - System Default Sound, page 43
  - Time Frames, page 43
    - Managing Time Frames, page 44
      - Create Time Condition, page 45
      - Modifying a Time Frame, page 45
      - Deleting a Time Frame, page 45
    - Sample Time Frames, page 46
  - Status Options, page 49
    - Create Status Option, page 50
Your personal Call Rules control what happens to your incoming calls. To manage or create your Call Rules, go to Features > Call Rules in the Extension Suite. This displays the Call Rules page, which has these Call Rule tabs:

- Unanswered Call Rule Sets (displayed by default)
- Busy Call Rule Sets
- Call Blocking Rules
- Messages/Prompts

**Tab Characteristics**

Each Call Rule set tab lists the default rules and any rules you have created for that type of call rule set, and it contains a Create Call Rule Set button. For each rule listed, you can modify or delete the rule by clicking its icon (shown under Actions). In addition, for Unanswered Call Rule Sets and Busy Call Rule Sets, you can disable/enable and activate the rules.

**Activating Call Rule Sets**

To activate a call rule set for a specific period of time, you need to define how long it will be active. Click its Activate button, then specify:

- A duration of time that begins immediately and runs as long as indicated.
- A date on which the rule deactivates. At 12:00 AM on that date, the rule is deactivated.

You can see the Active state of the rule set in the Call Rule Sets list.

**Prioritizing Call Rule Sets**

Your Call Rules need to be prioritized because Switchvox executes them from top to bottom. To prioritize your call rules, use the green arrow to the left of each rule in the list to move a rule set up or down.

In the example:

- Calls are handled one way during business hours, and another way outside of business hours.
- During business hours, multiple numbers ring at the same time and after 5 rings go to voicemail.
- Outside of business hours, calls go immediately to voicemail. (Notice there is no Time Frame on this rule set because during business hours Switchvox always follows rule number 1.)

**Prioritizing Actions in a Call Rule Set**

The Actions in your Call Rules need to be prioritized because Switchvox executes them from top to bottom. To prioritize Actions, use the arrows to the left of each rule in the list to move call rules up or down.
The following sections describe each tab.

**Unanswered Call Rule Sets**

**Unanswered Call** (displayed by default) is the call rule set in which you define actions that happen when your extension receives a call that is not answered.

Unanswered call rule sets can involve immediate action or action after a defined number of rings. The default call rule sends a call to your voicemail after five rings.

Each call rule set can include **Time Frames** during which the rule is valid. In that way, Switchvox can handle calls according to the time of day the call is received; for example, during business hours, in the middle of the night, or any other Time Frame you define.

Switchvox evaluates each of your Active Call Rules in the order they are listed and applies the rule when the call meets the rule criteria.

**NOTE**: By default, regardless of date and time, these Unanswered Call Rules apply:

- If your Status is Do Not Disturb, queue calls are declined and direct calls go immediately to voicemail.
- Otherwise, all calls go to voicemail after 5 rings.

**IMPORTANT**: You should always test your rules by calling your extension from another phone before activating the rule.
**Create Call Rule Set**

Click **Create Call Rule Set** from the unanswered Call Rules tab to display a General Settings popup.

![FIGURE 21. Unanswered Call Rule Set popup](image)

- Enter the **Rule Set Name**.
- Select the **Rule Set Time Frame** (when the rule set should be used) from the dropdown. Switchvox will evaluate the current date and time against this time frame, and if they match then the rule is followed. If they do not match, Switchvox moves on to the next rule. See *Time Frames, page 43* for more information.
- Select the **Rule Set Status** (what your current status is set as) from the dropdown menu.
- Click **Save Call Rule Set**. This saves the rule set, displaying a confirmation message and the Action tab/page.

![FIGURE 22. Call Rule Set Actions tab](image)
Create Action

- Click **Create Action** to associate an action with the rule. This displays a popup menu with types of actions. Choose a type from the list. After saving the action, if you want to associate more actions with the rule, click **Create Action** again and go through the process for each additional action.

![Action Type popup](image)

**FIGURE 23. Action Type popup**

Action types, their options, and their respective popup menus include the following:

**Send to Voicemail**

This sends the call to your voicemail so the caller can leave a message.

![Send to Voicemail Settings popup](image)

**FIGURE 24. Send to Voicemail Settings popup**

Enter the following information:

- **Type of Call.** Specify whether the rule applies to direct calls, queue calls, or all calls.
- **Number of times to ring.** Enter the number of times to ring your phone before initiating this action.
- **Unavailable Greeting.** Specify which voicemail greeting to play if you do not answer.
• **Busy Greeting.** Specify which voicemail greeting to play if you are on a call. Or, Use Unavailable Greeting if you don't want to use a different greeting than the one you chose for the Unavailable Greeting.

Click **Save Call Rule Set.** This saves the rule set, displaying a confirmation message and the Action tab/page.

**Call Forward**

This option forwards the call to another Switchvox extension. The extension can be another phone, a call queue, or any other type of extension. After a call is forwarded to the extension, the call rules for that extension are followed.

[FIGURE 25. Call Forward Settings popup]

Enter the following information:

• **Type of Call.** Specify whether the rule applies to direct calls, queue calls, or all calls.

• **Extension to Forward to.** Enter a Switchvox extension.

• **Number of times to ring.** Enter the number of times to ring your phone before initiating this action.

Click **Save Call Rule Set.** This saves the rule set, displaying a confirmation message and the Action tab/page.

**Call Cascade**

This action rings another extension or an external phone number (e.g., your mobile phone). If the call isn’t answered, then it is passed on to the next action. This action
Call Rules

depends on your Outgoing Call Provider. If your provider supports it, you can stack several rules to try and reach you at several phone numbers.

![Call Cascade Settings popup](image)

**FIGURE 26. Call Cascade Settings popup**

Enter the following information:

- **Type of Call.** Specify whether the rule applies to direct calls, queue calls, or all calls.
- **Number to forward to.** A Switchvox extension, or an external number. If this is an external phone number, enter the number as you would dial it, including a 9 or other necessary digits.
- **Number of times to ring.** Enter the number of times to ring your phone before initiating this action.
- **Attempt to preserve Caller ID.** YES indicates Switchvox should try to send the originating caller ID when it rings the number. This is not always possible, depending on the provider, but it will be attempted.
- **Acknowledge call.** YES indicates you want to acknowledge (accept) the call before Switchvox completes the call. Switchvox does not complete the call until you have answered it and acknowledged it by pressing ONE on your keypad. So, if the action rings this number and it is answered but not acknowledged, Switchvox continues to follow your Call Rules. This protects calls from being answered by unauthorized individuals.

**NOTE:** Acknowledge Call is useful if you might not be the person answering the phone number. It can also ensure that your calls end up in your Switchvox voicemail (as opposed to your voicemail at home, or on your mobile).

Click **Save Call Rule Set.** This saves the rule set, displaying a confirmation message and the Action tab/page.
Secret Code

This action prompts the caller to enter a secret code, then passes the caller to the next action. If the caller cannot enter the correct secret code after the specified number of attempts, then you can specify what to do with the call.

![Secret Code Settings popup](image)

FIGURE 27. Secret Code Settings popup

Enter the following information:

- **Type of Call.** Specify whether the rule applies to direct calls, queue calls, or all calls.
- **Secret Code to prompt for.** Enter one to 7 characters (0-9, *, or #).
- **Number of times to ring.** Enter the number of times to ring your phone before initiating this action.
- **Number of tries to allow.** Enter the number of times the caller can try to enter your secret code. After this number of tries, the following action happens:

  - **If code is incorrect,** then
    - Play Busy Signal
    - Play Congestion (fast busy tone)
    - Hang Up
    - Send to Voicemail

Click **Save Call Rule Set.** This saves the rule set, displaying a confirmation message and the Action tab/page.

Ring All

This rule simultaneously rings up to three extensions or external phone numbers. **IMPORTANT:** Ring All must include your main extension if you want that phone to ring. If you need to ring more than three phones, you may set up subsequent Ring All
actions that ring those additional phones. In this case, the first set of phones ring, and then the second set of phones ring.

![Ring All Settings popup](image)

**FIGURE 28. Ring All Settings popup**

Enter the following information:

- **Type of call.** Select from the dropdown menu the type of call to which the rule applies: direct calls, queue calls, or all calls.

- **Numbers to Ring.** Enter the Switchvox extension or an external phone number. Then click Add (+). Click the magnifier icon to search for an extension. If you are adding an external phone number, be sure to include a 9 or other necessary digits that you normally use to dial out.

  The numbers and extensions are displayed in a table. Click the entry’s green arrow to select that number. You can then choose to delete the number (click red X) or turn on or off Acknowledge Call. If Acknowledge Call is set, the call will be completed with an acknowledgement. To change that, select the number and turn Acknowledge Call off.

  Switchvox does not complete the call until you have answered it and acknowledged it by pressing ONE on your keypad. So, if the action rings this number and it is answered but not acknowledged, Switchvox continues to follow your Call Rules. This protects calls from being answered by unauthorized individuals.

- **Number of times to ring previous rule before ringing extensions.** Enter the number of times to ring your phone (from the dropdown menu) before initiating this action.

- **Attempt to preserve Caller ID.** YES indicates that Switchvox should try to send the originating caller ID when it rings the number. This is not always possible, depending on the provider, but it will be attempted.

Click **Save Call Rule Set.** This saves the rule set, displaying a confirmation message and the Action tab/page.
Decline

This action declines incoming calls. For Direct Calls, you can indicate the number of silent rings to be played to the caller after the call is declined.

Enter the following information:

- **Type of call.** Select from dropdown menu.
- **Number of times to ring previous rule before declining or starting silent rings.** Select from dropdown menu.
- **Number of rings to play direct callers.** These are silent rings. Note that queue calls are instantly declined and do not have silent rings.

When finished defining the action, click **Save Action.** This saves the rule set, displaying a confirmation message and the Action tab/page.

Prioritizing Actions

Switchvox executes Call Rules actions in top-to-bottom order.

- To prioritize actions, from the Actions tab/page, use the arrows to the left of each list action to move an action up or down.

When finished, click **Back to Call Rules.**

Modifying a Call Rule

From the Call Rules page, click the **Modify** icon for the rule for which you wish to make changes. This displays the Actions page with the list of action types associated with the rule. Each action type can either be modified or deleted, or you can add a new action to the rule set.
• Click the appropriate icon and make the necessary additions or corrections.

Click **Save Action** when finished.

*Activating a Call Rule Set*

Click a call rule’s **Activate** button, and specify how long the rule is to be active:

• A duration of time that begins immediately and runs as long as indicated.
• A date on which the rule deactivates. At 12:00 AM on that date, the rule is deactivated.

The Call Rule Sets list indicates for each rule its Active state.

*Busy Call Rule Sets*

*Busy Call Rule Sets* specify how a call is handled when you are on the phone (i.e., your line is busy).

![Busy Call Rule Sets tab](image)

**FIGURE 30. Busy Call Rule Sets tab**

To create a Busy Call Rule Set, set **Use Unanswered Call Rule Sets** to NO. That activates the Create Call Rule Set button. Click the button it to begin the process.

Busy Call Rule Sets use the same settings and actions as described for *Unanswered Call Rule Sets*, page 32.
**Call Blocking Rules**

Switchvox lets you specify phone numbers from which you do not want to accept calls. You can block specific phone numbers, any numbers that begin with the same prefix, and you can block them at all times or during specified time frames. You can also choose how Switchvox handles the blocked calls.

**FIGURE 31. Create Call Block Rules tab/page**

**Create Call Block Rule**

Click **Create Call Block Rule** to display the Block Rule Settings.

**FIGURE 32. Block Rule Settings popup**

Enter the following information:

- Select Phone Number or Prefix from the **What to block** dropdown menu.
Call Rules

**IMPORTANT**: Be careful using Prefix. If you put in the wrong prefix, you may block more calls than you expect.

- Enter the **Number to block**.
- Select the action Switchvox should take with the blocked call from the **Block and send** dropdown menu. Options include: Play Busy Signal, Play Congestion, Hang Up, or Send to voicemail.
- If you want to control when these calls are blocked, Select **Time Frames** from the **During the time frame** dropdown menu.
- Select the Rule Set Status from the dropdown menu.

Click **Save Action** to save your changes.

**Messages/Prompts**

These message/sound prompts are used in your Call Rules Secret Code actions. You can change the prompts by recording your own sound over your phone, or by uploading a new sound file.

![FIGURE 33. Messages/Prompts tab](image)
**New Sounds**  
(Messages)

- To upload or record your own sound, click the prompt’s **plus** button.

![FIGURE 34. Call Rules: Create a New Sound popup](image)

Select either Record Over Phone or Upload File from the dropdown.

- If you choose **Record Over Phone**, your phone will ring. Follow the directions from the phone to record the new message. Click finished, **Done**. This redisplays the Call Rules page with a message that your recorded sound was saved.

- If you choose **Upload File**, the system displays an Upload File box for you to locate the file. Click **Create New Sound**. This redisplays the Call Rules page with a message that your uploaded sound was saved.

**Play Sound**

From the Messages/Prompt page/tab, click the prompt’s **Play** button to play the sound.

**System Default Sound**

From the Messages/Prompt page/tab, click the prompt’s **Use Default** button to remove a sound that you created and restore the default sound.

**Time Frames**

By defining and associating Time Frames to call rules, Switchvox can operate differently based on the date, day, and time. A **Time Frame** is considered valid when the current date and time match any one of a Time Frame’s conditions. Not all of the rules have to match.
To manage or create Time Frames, go to **Features > Time Frames** in the Extension Suite. This displays the Time Frames page:

![Time Frames page](image)

**FIGURE 35. Time Frames page**

**Managing Time Frames**

Time frames consist of Time Frame Conditions. The time frame itself is considered valid when any of its conditions are met.

To create a new Time Frame, enter a **Time Frame Name** and click **Create**. This displays the Modify Time Frame Conditions page.

![Modify Time Frame Conditions page](image)

**FIGURE 36. Modify Time Frame Conditions page**
Create Time Condition

Click **Create Time Condition**. This displays the following popup.

![Time Condition popup](image)

**FIGURE 37. Time Condition popup**

- Enter a Date Range, Day of the Week Range, or a Time Range, or any combination.
- Continue adding conditions until you have completed the Time Frame definition.
- Click **Save Time Frame Condition**. This displays the Modify Time Frame Conditions page, with a message that the time frame was added and listing it.

Modifying a Time Frame

- To change a time frame, click its **Modify** button from the list of Time Frames. This displays the Modify Time Frame page for that frame.
  
  You can create a new condition, or delete any conditions that you do not want to include in this time frame. You cannot modify a condition.

Deleting a Time Frame

- To delete a time frame, click its **Delete** button. Be sure that you do indeed want to delete this time frame, then click **Yes, Delete Time Frame**. The Time Frames main page is deleted with a message that the time frame was deleted.

**IMPORTANT**: Before you delete a Time Frame, be sure you do not have any IVR Menus or Call Rules that depend on it.
Sample Time Frames

All Mondays and Wednesdays

FIGURE 38. Condition Screens for Setting all Mondays and all Wednesdays
Time Frames

Early Morning

FIGURE 39. Condition Screen for setting all mornings 3AM to 6AM

The First Week in July 2012

FIGURE 40. Condition Screen for setting first week in July 2012
**Weekdays in February 2012 between 6:00 and 7:00 in the morning**

![Figure 41. Condition Screen for setting weekdays February 2012 between 6 and 7AM](image)

**After January 21, 2012**

![Figure 42. Condition Screen for setting any time after January 21, 2012](image)
Status Options

Your personal Status Options are created under one of the main Status types: Available, Away, Prefer Chat, Extended, Away, or Do Not Disturb.

These Status Options are available to set from the Switchvox web interface or from your Digium Phone Status Ap.

NOTE: If you use a desktop chat client (such as Pigin) that automatically changes your Status based on your idle time, this could cause an unwanted effect to your Call Rules. For example, if you were idle in Pidgin for 5 minutes and your Status changes to Away, any Call Rules based on Status:Away will perform as if you were away from your phone, like forwarding your calls to your assistant.

To manage or create, go to Features > Status Options. This displays the Status Options page.

FIGURE 43. Status Options page
Create Status Option

Click **Create Status Option** to add a new status. This displays the Status Option Settings popup.

- Select the Status you wish to work with from the dropdown menu. Options are Available, Away, Prefer Chat, Extended Away, and Do Not Disturb.
- Enter a **Substatus** name.

Click **Save Status Settings**. This redisplays the Status Options page with the new status listed. Because this was user defined, the Owner is listed as User, and you can modify or edit this setting.

**NOTE**: To see how to create/modify your status from your Digium Phone see *Status App, page 65*. 
3 Calling & Contacts

The following sections describe how Switchvox handles calling as well as how the some of the Digium Phone Apps handle basic functionality:

Phonebooks, page 52
  Create Phonebook Entry Tab, page 53
  Extension, page 54
  External Number, page 55
  Agent Login Extension Indicator, page 56
  Parking Space Indicator, page 57
  Create Phonebook Tab, page 58
  Modify Phonebook Options Tab, page 59
  Phonebook for Rapid Dial Keys, page 59
  Digium Phone Contact Settings, page 59
  Additional Numbers, page 60
Conferencing, page 61
  General Settings, page 62
  Conference Admins, page 62
  Admin Settings, page 63
Digium Phone Calling Features, page 63
  Dialing Calls, page 63
  Receiving Calls, page 64
  Redial, page 64
  Hold/Resume, page 64
  Transfer, page 64
  Park, page 64
  Record/Stop Record, page 65
  Three-way Conference, page 65
Digium Phone Apps, page 65
  Status App, page 65
  Contacts App, page 65
  Queues App, page 66
Phonebooks

The Switchvox Phonebook feature lets you organize both internal and external contacts so you can easily access extensions and numbers from both your Switchvox Switchboard and your Digium Phone.

To create a Phonebook using the Web Extensions Tool, go to Features > Phonebooks. This displays the Phonebooks page from which you can create and manage your phonebooks and phonebook entries.

![Phonebooks page](image)

**FIGURE 45. Phonebooks page**

**NOTE:** To move an entry between Normal or Extended entries, drag the entry’s green arrow icon.

- To delete an entry, click its **Delete (X)** icon. You are asked to verify the deletion request. Click **Yes, Delete**. The Phonebook is refreshed, and this entry has been removed.
- To delete a Phonebook, click its **X** icon. You are asked to verify the deletion request. Click **Yes, Delete**.

**NOTE:** You cannot delete the Default Phonebook.

**NOTE:** If you have a D50 Phone, you can create a PDF DESI strip of a phonebook to insert next to the Rapid Dial Keys of your phone by using the **Print DESI Strip** tab.
Create Phonebook Entry Tab

There are different types of Phonebook entries, depending on whether it is an external phone number or a Switchvox extension. The following are entry types: Extension, External Number, Agent Login Extension Indicator, and Parking Space Indicator.

FIGURE 46. Phonebook Entry Types page
**Extension**

_Extension Settings_ are other Switchvox extensions. You can add user-type extensions and other types of extensions, such as queues or IVRs.

Click _Extension_ to display the Extension Settings popup:

![FIGURE 47. Extension Setting popup](image)

Enter the following information:

**Phonebook**

Select the Phonebook in which the entry will belong from the dropdown menu.

**NOTE:** If it is a new Phonebook, you must create it first using the Create Phonebook tab.

**Extension(s)**

Enter one or more extensions to the Phonebook. To find an extension, start typing the number in the text box and Switchvox will give you eligible suggestions. Select the number from the selections displayed and it is added to the Extensions table. Or click the search icon to display all eligible extensions in a scrollable window. Highlight any extension you want to add and click the Add button. If you want to select groups of extensions from the window, hold down the shift key. To select intermittent extensions, hold down the control key when highlighting the entry.
Permission Type

*Normal.* Shows the user’s Presence, and if he or she is on the phone. Also includes a dropdown menu that lets you open a chat, call additional numbers, or Intercom the person.

*Extended.* Shows the Normal features, plus the caller ID name and number of the user’s active calls. It also includes options to monitor, record, whisper, barge into, or pick up the user’s calls.

Only phone-type extensions can be Extended Permission entries. If you try to add any other type of extension (e.g., a Call Queue), it is added as a Normal entry. You can change an entry’s permission type at any time.

**NOTE:** If you cannot see or use an option in an Extended Entry, most likely your Switchvox administrator has not given you permission to do so.

*External Number*  
External Number entries are for names and phone numbers other than Switchvox extensions. Click **External Number** to display its popup.

![External Number popup](image)

**FIGURE 48. External Number popup**

**Phonebook**

- Select the Phonebook that this entry belongs in from the dropdown menu. To create a new Phonebook, first use the Create Phonebook tab.
Phonebooks

**Number**
- Enter the phone number.

**Name**
- Enter a name.

**Jabber ID**
- Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry. The Jabber ID has a user ID (the extension) and a Jabber Hostname. For example, 101@jabber.peeredswitchvox.com.

Click **Save Phonebook Entry** when ready.

After you add an external entry, you can put **Additional Numbers** into that entry by pressing the plus sign (+). Make sure to enter the additional number as you would dial it from your phone. For example, if you must dial 9 for an external number, an external number here must begin with a 9.

**Agent Login Extension Indicator**

This indicator entry controls a line status indicator light for agent login on your phone. The light is lit (green) when you are not logged in.

Click **Agent Login Extension Indicator** to display its popup.

**Phonebook**
- Select the Phonebook this entry belongs in from the dropdown menu. To create a new Phonebook, use the Create Phonebook tab.

**IMPORTANT**: This must be the same Phonebook as the one in the Phone Features Options for this entry to affect your phone. Also, it must be one of the
first entries in the Phonebook if you want it to display without having to scroll through the entries on your phone.

**Entry Name**

- Enter a name for this entry. This isn’t required, as you don’t see the entry in your Switchboard.

**Agent Login Extension Indicator**

- Enter the **Agent Login Extension** you use to log into this queue.

**Queue To Monitor**

- Enter the queue that you want to monitor. This lights up the line status indicator on your phone when you are not logged into the specified queue.

---

**Parking Space Indicator**

This entry controls a line status indicator light for parking space on your phone. Click **Parking Space Indicator** to display its popup.

![Parking Space Indicator Settings popup](image)

**Phonebook**

- Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

**Entry Name**

- Enter a name for this entry. This is not required because you do not see the entry in your Switchboard.

**Parking Space**

- This lights up the line status indicator on your phone when a caller is waiting in the specified Parking Lot Extension.
Create Phonebook Tab

Click **Create Phonebook** from the Phonebooks page. This displays the Create Phonebook popup.

![Create Phonebook popup](image)

**FIGURE 51. Create Phonebook popup**

- Enter a unique name for the Phonebook in the text box.
- Click **Save Phonebook**.
  
The Phonebooks page is redisplayed with a tab for the new Phonebook and the message that “There are no entries.”
- To add entries, click **Create Phonebook Entry** and proceed as described in *Create Phonebook Entry Tab, page 53.*
Modify Phonebook Options Tab

From the Phonebook main page, click the Phonebook that you want to modify, then click the Modify Phonebook Options to display the Phone Features Options page. Make changes as you wish, then click Save Phonebook Options when finished.

FIGURE 52. Phonebook Features Options page

Phonebook for Rapid Dial Keys

Choose the Phonebook to be used as contacts on your phone's Rapid Dial Keys (RDKs).

This can be used by both Digium Phones and Polycom phones with a Phone Feature Pack. A Polycom phone may need to be rebooted.

Digium Phone Contact Settings

Enable Line Keys for Rapid Dial

If this is YES, the unused Line Keys on your phone are used as RDKs. If it is NO, then your RDKs begin at the top on the right side of your phone.

NOTE: This is only for Digium Phones.

Click the Save Phone Features Options button when ready.

Blind Transfer Rapid Dial

If this is YES, it transfers using a Rapid Dial Key immediately.

Number of Rapid Dial Subscriptions

Move the gage along the bar until it is the number of contacts you wish to show Status on Rapid Dial Keys.
**Additional Numbers**

Each Phonebook entry is based on one main extension or phone number, but it can also have additional numbers associated with it. This way, you can have one Phonebook entry for a person and have all of their contact numbers included in that entry.

Each entry's Additional Numbers can be viewed from the **View Additional Numbers** icon for the entry (green plus sign icon).

Click the **Create Addition Number** button to define another additional number for the entry.

Enter **Title**, **Number**, and select an **Icon**.

Additional Numbers may have been created by an extension owner, or you can create them in your Phonebook entry.

- Additional Numbers entered by an extension owner are available when you add the extension to your Phonebook. These numbers appear as locked and cannot be edited, but you can choose to hide them in the Switchboard.
- Additional Numbers that you add to your Phonebook entry can be edited and deleted.
- You can also copy any Additional Numbers (including the owner’s numbers), and then edit or delete the copy.
**Conferencing**

Ask your Switchvox Administrator for the main conference room extension number. When a caller dials that number, he or she can access your conference room by dialing your conference room number, then the pound key (#). See *Three-way Conference, page 65*, for a description of the Digium Phone conferencing feature.

In the Extension Tool Suite, go to **Features > Conference Room** to display its main page.

![Conference Room page](image)

**FIGURE 55. Conference Room page**
General Settings

You can change the behavior of your conference room using the following general setting options.

Your Conference Room Number
Enter a unique 5-digit number for your conference room. This is the number that you give to callers so they can access your conference room. Click the arrow to have the system pick a random, unused room number for you.

Play sound when people enter/leave
YES indicates that the following sound type is played to all members of the conference room when a new caller enters the room. There are three options for the sound type that is played when a caller enters and exits your conference room:

- Only Sound. Only a sound is played, no information about the caller.
- Sound with Caller Name. The caller is prompted to record his or her name. The recorded name is then played along with a sound.
- Sound with Caller Name (User Review Option). This is the same as Sound with Caller Name, but it gives the caller an opportunity to listen to the recorded name, then accept or re-record it before joining the conference room.

Play Music On Hold when only 1 member is in the conference room
YES indicates Music On Hold (MOH) plays when only one person is in the conference room.

Conference members may press # and be sent to extension []
Enter an extension here, so when a member presses #, they are transferred to that extension.

Conference Admins

Conference Admins are special members of your conference room who have specific privileges. This collector box lets you find and collect extensions and/or Extension Groups that have Admin privileges for your conference.

Type a name or extension number into the text field. As you type, Switchvox offers suggestions of matching extensions.

Click the Find icon to display the extensions available in Switchvox. You can sort this view by the column headers. If you are working with phone-type extensions, you can expand the window to show an extension owner’s profile.
To delete an item from the collection, select it and click the Delete icon.

To select multiple items in the collection:

- Control-click to select two or more items that aren’t together in order.
- Click an item, then Shift-click another item to select both items and all items between them.

**Admin Settings**

The Admin Settings control what happens in a conference based on whether or not an Admin is present. The following are options:

- **Only allow conference admins to talk**
  
  YES indicates all non-admin callers can only listen, they cannot be heard in the conference room.

- **Hang up conference when all conference admins leave**
  
  YES indicates your conference room hangs up if there are no admins in the call.

- **Users cannot talk until a conference admin is in the conference room**
  
  YES indicates no one can be heard in the conference room until an admin is in the room. Callers can join the room, but they cannot speak to each other.

**Digium Phone Calling Features**

The following summarize how to use the common calling features of your Digium Phone.

**Dialing Calls**

Pick up the handset, or press a line key and dial a number.

- Or dial a number and press the Dial softkey.
- Or use Contacts or Call Log to find a number, then press the Dial softkey. If you use Contacts, you can dial a coworker’s Voicemail.
Receiving Calls

Pick up the handset, or press a softkey: **Answer**, **Ignore**, **Transfer**, or **Send VM**.

- **Ignore** makes the call stop ringing but uses your Call Rules.
- **Transfer** lets you transfer the call.
- **Send VM** sends the call to your voicemail regardless of your Call Rules.

Redial

Press the **Redial** button to redial the last call you made. If you have multiple lines, Redial automatically uses the correct line.

Hold/Resume

- During a call, press **Hold**. The line key flashes red.
- Press either the flashing line key or the **Resume** softkey to resume the call.

Transfer

There are three kinds of transfers:

**Assisted**

- During a call press the **Transfer** button.
- Enter a number or press the **Contacts** softkey to find a number.
- Press the **Dial** softkey. When someone answers, inform them of the call to be transferred.
- Press the **Transfer** softkey to complete the transfer.

**Unassisted (blind)**

- During a call, press the **Transfer** button.
- Enter a number or press the **Contacts** softkey to find a number.
- Press the **Transfer** softkey to complete the transfer.

**Transfer to Voicemail**

- If you used **Contacts** for a transfer, press the **Transfer VM** softkey instead of Transfer. That transfers the call to that contact’s voicemail.

Park

- During a call, press the **Park** softkey.
• Answer the call from any Switchvox phone by either dialing that Parking extension or by pressing the Parked Calls softkey and answering the call.
• From the idle screen: press the More... softkey, then Parked Calls.

**Record/Stop Record**

• During a call, press the **Record** softkey to begin recording.
• Press **Stop Record** when you are done. Recordings are in your voicemail mailbox.

**Three-way Conference**

• During a call, press either the **Conf** button or the **Conference** softkey on your phone.
• Make a call, or **Resume** another existing call.
• Press the **Conference** softkey again to connect all participants.
• To end the conference and put both call on Hold, press the **Split** softkey on either call.

See **Conferencing, page 61**, for more on conference calls.

**Digium Phone Apps**

The built-in Switchvox applications for Digium phones allow you to access your parked calls, interactive voicemail, call logs, call queue details, as well as monitor, record and conference calls directly from your desk phone. The following is a quick overview of the Contacts App, Queues App, and three-way conferencing.

**Status App**

To change your status from your Digium Phone, press its **Status** button or **Status** softkey. Your current status is displayed on your phone’s idle screen. Do Not Disturb sends incoming calls to your voicemail and declines queue calls.

Your coworkers see your Status on their phones and/or Switchboards. You can use Call Rules to manage incoming calls based on different Status Options.

**Contacts App**

It is easy to access all of your contacts directly from your Digium phone with a simple search, access to presence, and detailed information about your contacts. Contacts include all of the contacts from your Switchvox administrator and the contacts you
have placed in your phonebooks. Contacts are used for rapid dialing and for finding
detailed information about someone. You access Contact from within Transfer, Con-
ference, and Forward voicemail on your Digium Phone.

To see the Detail page for a contact, press the Show softkey in a list of contacts.
Details include the person’s Status.

Your contacts can also define your unused Line Keys and Rapid Dial Keys. See
Phonebooks, page 52, for more on this.

---

**Queues App**

Use the Queue App to log into and out of call queues and to view queue details. Press
the More...> Queue softkeys. Switchvox then fetches the Call Queues you have per-
mission to view.
You can access Switchvox Voicemail from the Extension Tool Suite's Mailbox, from your Digium phone, from an external phone, or from your favorite email client. However, the web-based Switchvox Extension Tool Suite is the primary means to check and manage your voicemail and faxes. The following sections describe the basic setup options for the Voicemail and Fax section of the Extension Suite, in addition to the Digium Phone Voicemail App and other information about voicemail.

Greetings Tab, page 68
Voicemail Notifications Tab, page 69
Notification Templates Tab, page 71
Forwarding Tab, page 73
Mailbox, page 74
   INBOX (Voicemail) folder, page 75
   Fax Folder, page 75
Digium Phone Voicemail App, page 78
Digium Phone Voicemail System Options, page 78
Putting the Mailbox on Your Desktop, page 79
Voicemail Options

Click Voicemail Options from Voicemail and Fax to set up your voicemail greetings and define how you want to receive notifications of a new voicemail message. The following describes the Voicemail Options as accessed from the Tool Suite (Voice-mail/Fax): Greetings, Voicemail Notifications, Notification Templates, and Forwarding:

Greetings Tab

Greetings are either recorded or uploaded sounds that play to a caller when you don’t answer the phone. You can upload an existing greeting sound file from your computer, or record a greeting using your phone. If you have not recorded a custom greeting, the default greeting is Switchvox reads your extension digits and says you are unavailable.

If you have recorded a Full Name Greeting (but not an Unavailable or Busy Greeting), the Full Name Greeting plays, then Switchvox says you are unavailable.

To specify which of your custom greetings play when your Call Rules are triggered, use the Send to Voicemail action in Call Rules (Features > Call Rules). (See Call Rules, page 31)

To specify which Unavailable Greeting plays when a call is sent directly to your voicemail, set that greeting as the Default, here on the Unavailable Greetings tab. For example, the default greeting plays when you press Send VM on an incoming call, or when someone else transfers a call directly to your voicemail.
Click the **Create Greeting** button from the Voicemail Options page to set up a new greeting. This displays the following popup:

![Create Greeting popup](image)

**FIGURE 57. Create Greeting popup**

Fill in the following fields:

- **Greeting Type**. Select from the dropdown menu.
- **Sound Name**. Enter a name for the greeting.
- **Sound Source**. Select either Record Over Phone or Upload File.
- **Extension To Ring**. Search for or enter the extension number for the greeting.

Click the **Ring Extension** button to record the greeting.

Click **Save Greeting** to save the sound file and redisplay the Greetings page with the new sound listed.

**Voicemail Notifications Tab**

Voicemail Notifications let you customize how you want to receive a notification when you get a voicemail message in Switchvox. You can set up multiple email
addresses, each with an email template and instructions for attaching the voicemail as a WAV file.

To add a new notification, click the **Create Voicemail Notification** button. This displays the Create Voicemail Notification popup.

- Enter your **Email Address**, select a **Template**, and select **YES** or **NO** to indicate whether or not to attach the voicemail WAV file to the email message. Then click the **Save Voicemail Notification** button. This redisplays the **Voicemail Notifications** tab with the list of notifications.
- To modify a notification, click its **Modify** (pencil) icon.
- To delete a notification, click its **Delete** (red X) icon. You cannot delete the local copy notification (that is the copy in your Switchvox IMAP mailbox), but you can...
change the template. This is the template that you will see if you subscribe to your Switchvox IMAP mailbox using your desktop email application.

- To **Delete Local Copy**, select either the **YES** or **NO** button. Yes indicates that a voicemail message is deleted from your Switchvox Mailbox after it is sent to your email address(es). This option lets you handle your voicemail entirely through your own email account.

**Notification Templates Tab**

Notification Templates let you customize your voicemail notifications to your email address. You can create multiple templates and tailor them to different types of email accounts. These custom templates are available (along with default templates) when you create or modify a Voicemail Notification.

To create a Notification Template, click its tab.

![Notification Templates Tab](image)

**FIGURE 60. Notification Templates Tab**
Click the **Create Notification Template** button to display the Template Settings page.

**FIGURE 61. Templates Settings**

- Enter the **Template Name** and its **Subject**. By default, %VM_CALLERID% is entered in the Subject field. This will print the caller’s name and phone number as subject. The template body contains other template variables. At the bottom of the page, there is a full list of variables you can use when creating or editing a template.
- Variables in your template are substituted with real values when the email is sent.
- Click **Save Notification Template** when finished.

**NOTE:** You can also create email addresses to receive notifications of a new incoming fax. This is useful if you want to be notified at both your work and personal email addresses, or if you want your administrative assistant to be notified. To create fax notifications, see **Fax Options, page 76**.

You can also preview, modify or delete the template.
Forwarding Tab

You can automatically forward all of your extension’s voicemail messages to other extensions in Switchvox. This is helpful for generic extensions such as “Accounting,” or “Shipping,” or for queue extensions such as “Customer Service.” Callers can leave a message on one extension, then the message is forwarded to the appropriate people. This is also useful internally, if you want to send a message to everyone in a group.

To set up forwarding options, click the Forwarding Tab. When finished, click Save Forwarding Options.

![Forwarding Tab](image)

**FIGURE 62.** Forwarding Tab

**Forwarding Options**

- **Enable Voicemail Forwarding.** Select YES to forward messages to an Extension Group, or to extensions.
- **Delete On Forward.** Select YES to delete each message from an extension’s Mailbox after the message is forwarded.
• **Forwarding Type.** Select from the dropdown menu either Send to All or Round Robin, the latter of which forwards each message to the next recipient, moving through the list of recipients in the same order as they are listed. If you are using Extension Groups, the groups are used in the order they are listed in the collection, and in the order given within the group itself.

**Forwarding Destinations**
Add the Extension Settings to forward to.

---

**Mailbox**

The Switchvox Mailbox lets you manage your voicemail and faxes in Switchvox.

Your Mailbox uses IMAP, a protocol that lets your desktop email application access remote messages as if they were stored on your computer. If you prefer to access your Mailbox from your desktop email, ask your Switchvox administrator for more information about how to do this.

Click **Voicemail/Fax > Mailbox** to view your Mailbox via the web interface. Use the **View Folder** dropdown menu to select a particular folder.

---

**FIGURE 63. Mailbox page**

Your voicemail comes into the **INBOX Folder** by default. If there are messages they are displayed in the INBOX Folder. Each message displays the original mailbox that it was left in (the message might have been forwarded to you by a co-worker), the caller ID of the caller (if it was available), the date and time the message was left, and the duration of the message.
**View Folder**

View Folder allows you to change mail folders by selecting from INBOX and its subfolders or from Fax and its subfolders:

**INBOX**
- Family
- Friends
- Recordings
- Work

**Fax**
- Drafts
- Outbox
- Sent

**INBOX (Voicemail) folder**

All voicemail for your extension comes into the INBOX folder.

- To play or download a message, click its Play button. This marks the message as Read (it is no longer shown as bold, and the message-waiting indicator light on your phone would go off if this was your only unread message).
- To delete messages, or mark them as read or unread, check the box for each message that you want to affect. Then, click the appropriate icon (at the top of the list). If you delete messages, you are prompted to verify the action. If you really want to delete the messages, click Yes, Delete.
- To move messages to a different folder, check the box for each message that you want to move, select the folder where the messages belong, then click Move To Folder.
- To forward messages to another Switchvox user, check the box for each message that you want to forward, select the extension to forward them to, then click Forward To.
- To sort by column in the message list, click the column name.

**Fax Folder**

Your faxes come into the Fax Folder. Your outgoing faxes are stored in the folders Drafts, Outbox, and Sent.

- **Drafts** includes the files you have printed to your Switchvox fax printer.
- **Outbox** includes faxes that Switchvox is currently trying to send (or was unable to send).
- **Sent** includes faxes that Switchvox has successfully sent.
Fax Options

Fax Options let you set up your faxing environment. You can enter multiple email addresses to receive notifications of a new incoming fax, create a fax header, and define this extension as only sending faxes.

NOTE: You must install a fax license and the fax software to make faxing available. For details, see this knowledge base article.

FIGURE 64. Fax Options page

Notifications Tab

You can Create, Modify, or Delete email addresses used for notifications of an incoming fax. This is useful if you want to be notified at both your work and personal email addresses, or if you want your administrative assistant to be notified.

Sending/Receiving

This option controls faxing for the extension. Enter information as indicated and click Save Fax Options when finished.

To send a fax, do the following:

- Check its box (you can only send one fax at a time),
- Click the fax icon (at the top of the list).
- Enter a fax number.
- Enter the number for the fax machine you want to send this fax to.
- Click Send Fax.
Fax Options

IMPORTANT: When you enter the fax number, be sure to prefix any digits that you normally use to dial out.

Your fax will be in the Outbox folder while it is being sent, then moved to the Sent folder after it has been successfully sent. If Switchvox cannot reach the other fax number to send your fax successfully, it remains in the Outbox folder.

NOTE: Switchvox sends fax notification email messages. These notification messages show the status of your fax. A Pending fax is still being sent (a fax may be Pending for a little while if Switchvox has to try multiple times), a Sent fax has been sent successfully, and a Failed fax was never received by the fax machine at the number you indicated.

Previewing

- To preview page 1 of a fax, click Preview.
- To view or download an entire fax, click Download. This marks the fax as Read (it is no longer shown as bold).

Deleting

- To delete faxes, or mark them as read or unread, check the box for each fax that you want to affect. Then, click the appropriate icon (at the top of the list). If you delete faxes, you are prompted to verify the action that you do want to delete the faxes, click Yes, Delete.

Moving to another folder

- To move faxes to a different folder, check the box for each fax that you want to move, select the folder where the faxes belong, then click Move To Folder.

Forwarding

- To forward faxes to another Switchvox user, check the box for each fax that you want to forward, select the extension to forward them to, then click Forward To.
- To sort by column in the message list, click the column name.

For more information, see Faxing, page 81.

Print a fax-file

Put it in the Fax.Outbox folder in the extensions’s Mailbox

Send the fax

No indicates that this extension may make voice calls and send faxes.

Treat All Outgoing Calls as Faxes

Selecting YES indicates that this extension is actually a fax machine and won’t make any voice calls. Switchvox handles all outgoing activity as a fax:

- Print a fax-file
- Put it in the Fax.Outbox folder in the extensions’s Mailbox
- Send the fax
Selecting NO indicates that this extension may make voice calls and send faxes.

**Fax Header**

Enter a **Fax Header** to include on each fax you send. For example:

- Digium, Inc. | 256.428.6000 | Fax: 256.864.0464

This is the information printed along the top of your fax pages (not to be confused with a cover page).

**Advanced Options**

If you want to specify additional fax options such as local station ID and various transmission rates, click the Arrow button to display the fields to fill in.

- Local Station ID
- Disable ECM for G711 Fax Sessions
- Min Transfer Rate for Fax Transmissions
- Max Transfer Rate for Fax Transmissions
- # Of Maximum Expected T38 Packet Delay (ms)

---

**Digium Phone Voicemail App**

The built-in Voicemail application for your Digium Phone allows you to use interactive voicemail directly from your desk phone. When you have unplayed messages, the message waiting indicator (on the top right of your phone) flashes red.

Press the **Msgs** button to display your Voicemail INBOX. Any message with an asterisk (*) has not been played. To listen to a message, select it and press the **Play** softkey.

---

**Digium Phone Voicemail System Options**

When you call the Voicemail system, you have many options

- **Listen** to a message
- **Forward** a message
- **Save** a message
- **Reply** to a message
- **Call-back** the person who left a message
- **Navigate** voicemail folders
- **Record** greetings
Putting the Mailbox on Your Desktop

Your Switchvox Mailbox uses IMAP, a protocol that lets your desktop email application access remote messages as if they were stored on your computer. In this case, it means that you can access your voicemail and faxes in your Switchvox Mailbox using your regular email application (e.g., Microsoft Outlook or Mozilla Thunderbird).

Your Switchvox Mailbox does not offer outgoing mail service, so if you want to forward a message or a fax from your email client, then you need to use your regular email account for that outgoing email message.

To set up your Switchvox IMAP Mailbox in your desktop email application, you’ll need the following information:

The IP address or domain name of your Switchvox mail server. This is the same IP or name that you use for the Switchvox Extension Suite.

Your email address, which in this case is your extension number, the @ sign, then your IP address or domain name. For example:

101@192.168.0.100 or 101@pbx.mybusiness.com.

Your user name, which in this case is your extension number.
Your password, which is the same password that you use to log into the Switchvox Extension Suite and to collect your voicemail.

In your email application, start the process to create a new Internet email account. When you are prompted to enter the type of incoming mail server for the account, choose IMAP. Enter the rest of the information as prompted.

**IMPORTANT:** If you are having trouble using your Switchvox IMAP account in your email application, talk with your Switchvox administrator. It is possible you need to use a different port number than the default (143), or you need to set specific security options.

---

**Subscribing to Folders**

After you have your Switchvox IMAP account set up in your desktop email application, you can manage the same folders that are in the Switchvox Mailbox (**Voicemail / Fax > Mailbox**).

You can subscribe to all of the folders, or just the ones you want to use. If you unsubscribe to a folder, it still exists in your IMAP account, it just isn’t shown in your email application. You can always subscribe to it again later.

You can also create folders using your desktop application, and those folders are accessible in your Web Suite Mailbox.

To subscribe to your IMAP folders in Microsoft Outlook, highlight your Switchvox IMAP Inbox and select **Tools > IMAP Folders**.

To subscribe to your IMAP folders in Mozilla Thunderbird, highlight the account and select **File > Subscribe**.

In both applications, the IMAP Folders window is displayed where you can subscribe and unsubscribe.
5 Faxing

The following sections describe how to set up a FAX printer and how to send a FAX:

Setting Up a FAX Printer, page 81
Sending a Fax, page 82

Setting Up a FAX Printer

Ask your Switchvox administrator whether or not faxing is available on your Switchvox. To make faxes for Switchvox, you need to first set up a generic printer that you can use from any application. You only have to do this once.

Depending on your desktop environment there are many ways to set up a printer, but there is some specific information that you need to set up a Switchvox Fax Printer:

- For Windows-based operating systems, the URL is http://YourDomain:631/printers/faxprinter
  
  YourDomain is the domain that you normally use for Switchvox. This may be an IP address or a domain name.

- For Linux- or Macintosh-based operating systems, the URL is http://ext:password@YourDomain:631/printers/faxprinter
  
  ext is your extension
  
  password is the password that you use for Switchvox voicemail
  
  YourDomain is the domain that you normally use for Switchvox. This may be an IP address or a domain name.

- For any operating system, use a generic postscript printer driver:
• For Windows-based operating systems, choose the generic driver MS Publisher Colored Printer.
• For Linux- and Macintosh-based operating systems, choose the generic driver Postscript Printer.

Sending a Fax

After your fax printer is set up, you can create a fax from any application.

• In your document, select the Print option. In the Print dialog box, select the new ‘faxprinter’ as the printer to use, and print the file.
• Go to the Extension Suite Voicemail / Fax > Mailbox.
• Select Fax:Drafts from the View Folder dropdown. Your Fax:Drafts folder is opened, and your drafts are listed.
• The page you just printed is in the list. You can preview the first page, or download a PDF of the entire fax.
• Check the box for your fax
• Click the fax machine icon (at the top of the list).
• Enter the number for the fax machine you want to send this fax to.
• Click Send Fax.
• Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been successfully sent.
6 Reporting

These reporting features are described in the following sections:

- Call Logs, page 83
- Call Reports, page 84

Call Logs

A Call Log is a simple list of the calls that have been made to or by your extension. You can select a date range by setting the From and To dates.

Reporting > Call Logs displays the Call Log page.

- Enter From Dates and To Dates to list calls for a date range.
- Click View Log to display the results at the bottom of the page under Call Logs. Click Output to .xls File to download an xls file of the log you can open with an application such as Microsoft Excel.
  The Call Log results include the call date, who the call was from and to, the type of call (incoming or outgoing), the call time, and the talk time.
- To display the details Switchvox collected for a call, click the call's Actions icon.
**Call Reports**

**Call Reports** lets you generate a call activity report based on a date-range and criteria you specify. Output can be in chart, list, browser, and XML form. Charts are only available for one breakdown field at a time.

**Reporting > Call Reports** displays the Call Reports page.

- Enter **From** and **To** dates to process calls for a date range.
- Select **Yes** or **No** to ignore weekends if your organization is not active on weekends.
- Select a Report Breakdown from the dropdown. Options include:
  - By Date
  - By Account
  - By Hour of Day
  - By Day of Week
  - Total accumulative
- Select a Report Field from the list. Options include:
  - **Total Number of Calls** incoming and/or outgoing
  - **Total Number of Outgoing Calls**
  - **Total Talking Time** that this extension actively spent with the call
  - **Total Call Duration**, includes time spent in an IVR or waiting in a queue
  - **Average Talk Time per Call**
  - **Average Call Time per Call**
- Click **Chart Report** to display the results in a graph according to breakdown and report field selected.
- Click **View Report** to display results at the bottom of page in Call Report.
- Click **Output to .xls File** to download an xls file of the log you can open with an application such as Microsoft Excel.

The Call Report results include the call date and the field type data for that date.
Switchboard is a browser-based, graphical display of what’s happening on Switchvox. It shows your own calls, your coworkers’ calls, call-queue activity, and your parking lot. You can drag and drop to transfer calls, and one click lets you make a call, pick up calls, record or monitor calls, log in and out of call queues, and more.

In addition to all of the Switchvox interaction, the Switchboard is also “Web Aware,” which means you can integrate other web applications with your call activity. Built-in panels bring SugarCRM, Salesforce, and Google Maps to the Switchboard, and you can build custom panels that use the URL of your choice.


The following sections give an overview of this unique Switchvox feature:

Using the Switchboard, page 86
Options, page 88
Switchboard Panels, page 89
  Current Calls, page 89
  Directory, page 90
  Parking Lot, page 90
  Profile, page 90
  Phonebook, page 91
  Chat, page 92
  Queue, page 92
  CRM, page 93
  Google Maps, page 93
  Custom, page 93
  Popup URLs, page 93
Using the Switchboard

To open your Switchboard, click the **Switchboard** button in the upper right corner of the Extension Suite main page (see arrow below).

![Extension Suite Main Page](image)

FIGURE 66. Extension Suite Main Page
Using the Switchboard

This loads the Switchboard for your extension.

In the upper right of the Switchboard, you can see the number of voicemail messages you have, new and old. There are also an Options dropdown menu that lets you control your Switchboard and a My Status dropdown menu that lets you change your status. The arrows in Figure 67 point to these features.

Your Switchboard lets you have up to six active lines on your extension (in the Current Calls panel), regardless of your phone’s capabilities.
Options

The Options dropdown (shown below) lets you control what is on your Switchboard, and how it is laid out. It also lets you select the phone you want to use from your list of converged phones.

**FIGURE 68. Options Dropdown Menu**

The following describe the menu options.

**NOTE:** Your Switchvox administrator must give you permission to use many of the features. If you see a feature described here that is not available to you, ask your administrator.

**Save Layout**

Save Layout lets you save your Switchboard window and panel layout. The next time you open the Switchboard, the window is the same size, and the same panels are open in the same place.

**Panels**

Panels let you open and close all of the Switchboard panels you have permission to use. Each of your Phonebooks is available as a separate panel. See Switchboard Panels, page 89 for descriptions of each panel.

**My Phone**

My Phone lets you select the phone you want representing you from a list of your converged phones.
Switchboard Panels

Current Calls
Current Calls displays all of the active calls on your extension and gives you many options for handling those calls. You can have as many as six current calls in the Switchboard, even if your handset does not support that many.

NOTE: To use a Converged Phone with your Switchboard, select that phone from the My Phone dropdown menu.

Send Call
If you choose not to answer a call, click Send to send the call to your Call Rules. The default rule is to send your calls to voicemail.

Hold & Resume
When you are on a call, click the Hold button to put the call on hold. The button then renames itself to Resume. Click Resume to return to the call.

Take Another Call
You can put an active call on Hold, then answer another incoming call. In fact, you can have as many as six current calls in the Switchboard, even if your handset does not support that many.

Transfer: Assisted & Blind
To transfer a call to someone in your Phonebook, just click the call and drag it from Current Calls to the Phonebook entry. You can transfer a call at any time, even if you have the call on hold, or the other extension is on an active call.

In an assisted transfer, you put the caller on hold, call your coworker to let him/her know you’d like to transfer a caller, then complete the transfer. In a blind transfer, you would just drag the call to the Phonebook entry.

Transfer to Voicemail
To transfer a call to your coworker’s voicemail, just click the call and drag it from Current Calls to the Phonebook entry’s envelope icon. This is handy if you know your coworker isn’t able to take the call.

Record
When you are on a call, you can click to start and stop a recording of your call. The recording is sent to your voicemail Mailbox, where you can save or forward it. It is up to you to let the other party know you are recording the call.
Directory

Directory offers you access to an Internal Directory defined by your Switchvox administrator. You can click and drag a call to an entry in the Directory panel to transfer the call to that extension.

Parking Lot

Parking Lot lets you “Park” a call so the call can be picked up at a different extension. To Park a call, just click and drag the call to the Parking Lot panel. Then, you or any of your coworkers can pick up a phone and dial the Parking Lot extension to be connected to the caller.

NOTE: An extension must have permission to pick up a parked call.

Profile

Profile displays the profile of the extension owner you are talking to. Profile information can be entered by the Switchvox administrator, or by the extension owner. See My Account, page 9 for more about profiles.

Profiles can be shown in the Switchboard and on a phone that uses a Phone Feature Pack.

This panel also offers the following one-click options to reach extensions:

Chat
Start a chat with an extension.

Call
Call an extension. The Switchboard rings your phone, and then when you answer it rings the extension. (You may be able to set up your phone so it automatically answers calls from the Switchboard; see Auto-answer Switchboard initiated calls, page 16.)

Voicemail
Call the voicemail for the extension. The Switchboard rings your phone and after you answer, it rings the extension's voicemail box so you can leave a message. (You may be able to set up your phone so that it automatically answers calls from the Switchboard; see Auto-answer Switchboard initiated calls, page 16.)
Phonebook

Phonebook displays the entries in a Phonebook. You can click on any entry to dial that number. Some extensions can display as Extended Entries, to help you communicate more effectively with that person.

Normal Entries

Normal Phonebook entries show your coworkers’ extensions or your frequently dialed external phone numbers. Each extension is shown with its Presence information, and you can click on any of them to speed dial the extension or number.

Normal entries have plus (+) icons with options to dial that person’s Additional Numbers, chat, or Intercom.

NOTE: You must have permission to use Chat and Intercom. Chat may not be available if for some reason you can’t chat with that person.

Extended Entries. Extended Phonebook entries have all of the normal extension options, but they also let you do the following with that extension’s calls:

• Pick up an incoming call
• See who the caller is
• Record the call
• Monitor the call (the callers do not hear you)
• Barge into the call (both callers hear you)
• Whisper on the call (only your co-worker hears you)

NOTE: You must have permission to use each of the following options.

Status

All Phonebook entries display the person’s Status, which helps you and your coworkers be selective about what calls to transfer to each other. An Away or Extended Away Status can include comments.

Intercom

All Phonebook entries can include the Intercom option, which lets you talk to a co-worker through the speaker on his/her phone, and the recipient doesn’t need to pick up the handset to answer your call.

Pickup

Extended Phonebook entries can include the Pickup option (the green ‘up’ arrow). One click and your coworker’s incoming call rings your extension also.

Record

Extended Phonebook entries can include the Record option. One click records the call, and sends the recording to your voicemail Mailbox.
Monitor

Extended Phonebook entries can include the Monitor option. If you monitor a call, the callers cannot hear you.

Barge

Extended Phonebook entries can include the Barge option. If you barge into a call, both of the callers can hear you.

Whisper

Extended Phonebook entries can include the Whisper option. If you whisper into a call, the caller cannot hear only (only the extension owner can hear you).

Chat

Chat lets you text interactively with your Switchvox coworkers. The main page of the Chat panel offers a list of people you can double-click to start a chat. Or, enter a Jabber ID and click Start Chat.

NOTE: Third party desktop chat clients, such as Pigin, can be used with Switchvox’s XMPP server in addition to the Switchboard Chat feature. Be aware that if the chat client automatically changes your Status based on your idle time, it may cause an unwanted affect to your Call Rules. For example, if you are idle in Pidgin for 5 minutes and your Status changes to Away, and you have a Call Rule based on Status: Away, the Call Rule will behave as if you were away from your phone and forward your calls to another number.

NOTE: You must have permission to use this.

Queue

Each Call Queue panel in your Switchboard contains views into that queue’s activity and statistics for the day.

For queue members, you can log into or out of each queue with one click. Or, you can pause your status and add a comment, letting your co-workers know why you’re unavailable and when you’ll be back.

NOTE: You must have permission to use this.
CRM

CRM panels integrate with your CRM application. When a call rings your phone, all of the information for this customer is displayed immediately, before you even answer the phone!

NOTE: You must have permission to use this.

Google Maps

Google Maps shows you where your caller is on a map based on area code and prefix. A popup window lets you scroll through previous callers’ locations.

NOTE: You must have permission to use this.

Custom

Your Switchvox administrator may have set up custom panels that integrate with Web applications. Ask your administrator for more information.

Popup URLs

Your Switchvox administrator can write external applications that set a display URL for each incoming call. If this value is set, then the URL button lights up and clicking it opens a new window with the specified URL. If you want that window to automatically open when a call comes in, click the green plus sign at the top-right of the panel.